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Objectives

The manual aims to provide a detailed and comprehensive methodology for mapping rock glaciers in 
Google Earth. The method was developed to support an assessment of permafrost distribution in the 
Hindu Kush Himalayan (HKH) region and the examples are based on this study.

The objectives are

�� to provide a step-by-step manual on how to map rock glaciers in Google Earth,

�� to provide examples of the diversity of rock glaciers encountered, of permafrost related features, and 
of how to classify rock glaciers, and

�� to provide a step-by-step guide on how to extract spatial attributes from the mapped rock glaciers.
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1. Introduction

Permafrost is defined as lithospheric material that remains at or below zero degrees Celsius (0oC) for 
at least two consecutive years (William and Smith 1989). The near-surface layer above it thaws during 
the warm season and is termed the ‘active layer’. The definition is thermal rather than visual, thus it is 
difficult to identify permafrost simply by looking. To directly measure permafrost, either a borehole or 
excavation is needed, which is expensive and laborious. Thus data on the occurrence and distribution 
of permafrost are scarce, especially in remote regions and developing countries. It is possible, however, 
to partly overcome the problems associated with direct measurement by measuring and mapping 
proxy components that are directly related to permafrost, such as ground surface temperature or 
geomorphologic features.

The term rock glacier is used to describe a creeping mass of ice-rich debris (i.e. permafrost material) 
on mountain slopes (e.g. Capps 1910; Haeberli 1985). Rock glaciers often have a lobed shape with 
longitudinal or transversal flow structures (ridges and furrows) and a characteristic frontal appearance, and 
the texture of the rock glacier surface frequently differs from the texture of surrounding slopes (Figures 1 
and 2). The presence of ground ice at depth, usually inferred from signs of recent movement, is indicative 
of the presence of permafrost. In areas with a continental climate, like those commonly found in the Hindu 
Kush Himalayan (HKH) region, surface ice interacts with the permafrost and results in complex mixtures 
of buried snow or glacier ice and segregated ice formed in the ground. In such environments, a range 
of transitions can occur from debris-covered polythermal or cold glaciers to ice-cored moraines and 
deep-seated creep of perennially frozen sediments (e.g. Owen and England 1998; Shroder et al. 2000; 
Haeberli et al. 2006). In this manual, we use the term rock glacier to describe any landscape feature with 
the morphological appearance of creeping permafrost. The most likely origin of the ice is not used as an 
exclusion criterion for glacier-derived ice. 

The occurrence of rock glaciers is governed both by the thermal regime of the ground and by the 
availability of subsurface ice either derived from snow avalanches or glaciers or formed directly in 
the ground. The other requirements are a sufficient supply of debris and topography steep enough to 
promote significant movement. The presence of intact (active and inactive) rock glaciers is an indicator 
of permafrost occurrence, but the absence of intact rock glaciers does not indicate the absence of 
permafrost. As intact rock glaciers contain ice (latent heat) and move (or have moved) downslope, their 
termini can be surrounded by permafrost-free ground. Rock glaciers are frequently covered with coarse 
clasts, which further retards the melting of the ice within the rock glacier. In steep terrain, the termini of 
rock glaciers can be taken as local-scale indicators for the presence of permafrost, and the elevation 
of the terminus can be taken as an indication of the lowermost occurrence of permafrost in that area 
(Haeberli et al. 2006). In more gentle terrain, such as parts of the Tibetan Plateau, the slope angle is 
often the limiting factor for formation of rock glaciers, even where permafrost is present. In these areas, 
rock glaciers may be absent over large areas of permafrost due to low slope angles, lack of debris, lack 
of avalanche snow, or high elevation of the valley floor. 

The tendency for rock glaciers’ termini to indicate the lowermost occurrence of permafrost in (steep) 
mountain areas is exploited in the mapping exercise described here.
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Figure 2: Rock glacier (A) photo (D. Stumm), and (B) Google Earth image

Figure 1: Schematic diagram of a rock glacier
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2. Methodology

The method presented here was specifically developed to support systematic analysis of rock glacier 
distribution in randomly distributed squares in the HKH region, but it can be applied in any geographical area. 

2.1	 Overall procedure and software
The following software is required: 

�� 	GNU R to create randomly distributed sample polygons.
�� 	Google Earth to map rock glaciers within the sample polygons.
�� 	ArcGIS 9.3 to extract spatial attributes for the sample polygons and the mapped rock glaciers. (Later 

versions of ArcGIS may show small differences in the commands, but the principle of the approach 
remains the same.)

GNU R, or simply ‘R’, is a scripting language for manipulation and analysis of statistical data and can be 
used to create randomly distributed samples. Specific packages are required to work with spatial data in 
R. The packages used in this study were ‘maptools’ (Bivand and Lewin-Koh 2014), ‘sp’ (Pebesma 2005; 
Bivand and Pebesma 2013), and ‘ggplot2’ (Wickham 2009). Once the random sample polygons have 
been created, rock glaciers found within the sample polygons are mapped by different observers using 
Google Earth. ArcGIS is then used to extract spatial information (mean minimum elevation) for the rock 
glaciers within the sample polygons. 

Figure 3 shows the overall schematic mapping and analysis process and the use of the software.

Figure 3: Flow chart illustrating the overall mapping and data analysis procedure. M1 and M2 are sets of KML 
files with the polygons mapped for rock glaciers by observer 1 and observer 2, respectively.

GNU R

Import 
all samples

Set M1

Set M1 Set M2

Set M2

Intersect to obtain commonly 
mapped rock glaciers

Convert the multipart features  
into single part features

Summarize the statistics of the 
mapped rock glaciers using DEM

All commonly mapped rock 
glaciers and samples with 
their relevant statistics for 

further analysis

Create randomly  
distributed sample  

polygons

Obtain data for first-order 
validation for permafrost maps

Use data for model 
validation and other 

applications considering 
the absence of ground 
measured data in the 

investigation area

Google Earth ArcGIS

Map all the samples  
(each by two different persons)

Rock glacier(s) mapped (RM)

No rock glacier (NR)

Insufficient image quality (IQ)
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2.2  Creation of randomly distributed sample polygons
Sample polygons for mapping should be randomly distributed in the investigation area in order to obtain 
an unbiased result. Thus the first step is to delineate the investigation area with a polygon and then use 
GNU R to continuously fill this area with randomly distributed square sample polygons as follows.

Use the user defined function f.RandomPolygon() to generate randomly distributed square sample 
polygons in the Keyhole Markup Language (KML) format, which is readable in Google Earth. The 
function can be downloaded from (http://www.the-cryosphere.net/9/2089/2015/tc-9-2089-2015-
supplement.zip). Each sample polygon is given a unique name consisting of two capital letters and three 
numbers. The first sample polygon is named AA001. The function used to create the randomly distributed 
sample polygons is f.RandomPolygon (in.file.shp, out.file.kml, sample.start, sample.end, sample.length)

Define the following five arguments:
�� 	in.file.shp: this is an input shapefile containing the investigation area delineated by a single polygon 

within which the randomly distributed sample polygons will be created.

�� out.file.kml: this is the name and location of the KML output file with the randomly distributed sample polygons.

�� 	sample.start and sample.end: These numbers specify the location and name of the sample to be used 
to start and end the creation of sample polygons. The number of polygons in the output file is equal to 
the difference between sample.start and sample.end, i.e.:

1.  sample.start = 1, sample.end = 50, creates 50 randomly distributed polygons starting at AA001
2.  sample.start = 50, sample.end = 100, creates 50 randomly distributed polygons starting at AA050

�� 	sample.length: This is the latitudinal width of each sample polygon in decimal degrees (DD). An 
approximate adjustment is applied for longitudinal width (see below). 

The steps integrated in the f.RandomPolygon() function to create the sample polygons in KML format 
are briefly as follows:
The readShapePoly function from the maptools package is used to read the data from the polygon 
shapefile (i.e. in.file.shp).

�� 	The fortify function from the ggplot2 package is used to extract the coordinates from the shapefile.

�� 	Each sample (i.e. one square sample polygon) needs to be created with a specified latitudinal length 
(LATL) and longitudinal length (LONL). The LATL is already specified for each sample (i.e. polygon side 
length in decimal degrees). An approximate adjustment is applied for LONL as follows, where LAT is 
the latitude for a specific sample.	

�� 	Five points with longitude, latitude coordinates are used to define a sample square polygon; four of 
the points represent the corners, while the fifth point is needed to close the square (and is identical 
to the first point). The output is a list with longitudinal coordinates in the first column and latitudinal 
coordinates in the second column forming a closed square (the first row equals the fifth row). 

�� 	The sample function is used to create random sample polygons with a defined sample size.

�� 	Every sample polygon is assigned a unique name i.e. which includes letters (uppercase or lowercase), 
numbers, or a combination of both. The LETTERS function is used to assign uppercase letters and the 
sprintf function to create formatted combination of text and variable values which feed in the values 
that differ in each loop.

�� 	Finally, the kmlPolygons function from the maptools package is used to export the samples into a KML file.

Manual for Mapping Rock Glaciers in Google Earth 
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 Each sample (i.e. one square sample polygon) needs to be created with a specified 

latitudinal length (LATL) and longitudinal length (LONL). The LATL is already specified 

for each sample (i.e. polygon side length in decimal degrees). An approximate 

adjustment is applied for LONL as follows, where LAT is the latitude for a specific 

sample. 
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 Five points with longitude, latitude coordinates are used to define a sample square 

polygon; four of the points represent the corners, while the fifth point is needed to close 

the square (and is identical to the first point). The output is a list with longitudinal 

coordinates in the first column and latitudinal coordinates in the second column forming 

a closed square (the first row equals the fifth row).  

 The sample function is used to create random sample polygons with a defined sample 

size. 

 Every sample polygon is assigned a unique name i.e. which includes letters 

(uppercase or lowercase), numbers, or a combination of both. The LETTERS function 

is used to assign uppercase letters and the sprintf function to create formatted 

combination of text and variable values which feed in the values that differ in each 

loop. 

 Finally, the kmlPolygons function from the maptools package is used to export the 

samples into a KML file. 

The output is a file with a total of n square-shaped sample polygons with a latitudinal length of 

sample.length in the KML format used for rock glacier mapping. 

[NOTE: If you get the following message Error in sample.int(length(x), size, replace, prob): 
cannot take a sample larger than the population when 'replace = FALSE' then the number 

of output polygons exceeds the number of possible polygons within the boundary defined by 

in.file.shp. In this case either decrease the number of polygons (use a smaller difference 

between sample.start and sample.end) or decrease the sample.length (size of polygons).] 



5

The output is a file with a total of n square-shaped sample polygons with a latitudinal length of sample.
length in the KML format used for rock glacier mapping.

[NOTE: If you get the following message Error in sample.int(length(x), size, replace, prob): cannot take a 
sample larger than the population when ‘replace = FALSE’ then the number of output polygons exceeds the 
number of possible polygons within the boundary defined by in.file.shp. In this case either decrease the 
number of polygons (use a smaller difference between sample.start and sample.end) or decrease the 
sample.length (size of polygons).] 

2.3  Rock glacier mapping in Google Earth by individual observers
After the randomly distributed sample polygons have been created in KML format, they can be inspected 
for the presence of rock glaciers using Google Earth (Figure 4). There is considerable variation in the 
rock glacier outlines mapped manually by different people using high resolution Google Earth images. 
To reduce this subjectivity, each sample polygon should be mapped by at least two people independently 
(usually using different computers). This will lead to at least two separate layers of mapping (M1 and M2) 
for each set of KML files. 

The following steps are conducted by each observer separately. 
�� Load the KML files with the randomly distributed sample polygons into Google Earth by double 

clicking on KML files, or Google Earth > File > Open > Select KML files, and uploading the files in the ‘My 
Places’ folder ready for further analysis (Figure 5).

Figure 4: White dots represent the randomly distributed sample polygons defined in the study within the 
defined boundary (yellow) of the study area (HKH boundary) as displayed in Google Earth.
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2.3.1	 Mapping the sample polygons

The mapping procedure involves the following steps:
�� 	Assessment of entire sample polygon
�� 	Assigning labels to sample polygons
�� 	Delineation of rock glacier outlines
�� 	Labelling rock glaciers

Assessment of sample polygons
Visually inspect all polygons for the presence of rock glaciers by checking each sample polygon in the 
Google Earth image (Figure 6A). Several Google Earth features can be used in the detailed inspection. 
You can navigate through the images using either the arrow keys, a mouse, or the navigation controls 
(Look joystick and Move joystick) in the top right corner of the 3D viewer (Figure 6B). The speed of 
navigation can be adjusted (Google Earth > Tools > Options > Navigation) to enable efficient inspection of 
every part of the sample polygon. 

You can zoom in and out of 
the Google Earth image while 
searching inside a sample 
polygon using either a mouse, 
the keyboard (Ctrl + Shift + 
Arrow Key), or the zoom slider 
in the middle right corner of the 
3D viewer. 

You can also tilt the view 
using shortcuts (Shift + Arrow 
Key) or the navigation slider 
(Move joystick). This Google 
Earth function is very useful for 
viewing mountainous terrain 
and for mapping rock glaciers 
as it helps to distinguish 
changes in elevation. 

Figure 5: Example of a KML file uploaded into the ‘My Places’ folder in Google Earth

Figure 6: Example of a sample polygon (A) and 
navigation tools available in Google Earth (B)

                                        (A)                                                    (B)
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Use all image layers available in Google Earth to ensure comprehensive mapping of the sample 
polygons. If you suspect the presence of a rock glacier but it isn’t clear, study earlier images to see if 
the same features are present. Activate the historical imagery in Google Earth (Google Earth > View > 
Historical Imagery, or Click on Clock icon) to see earlier images (Figure 7).

Figure 7: Activated time slider in Google Earth to view historical images

Assigning labels 
Assign a label to every sample polygon as follows (Table 1). If no rock glacier is seen, add the label 
NR (no rock glacier) to the polygon name. If any rock glaciers are identified, add the label RM (rock 
glacier(s) mapped). If it is not possible to detect rock glaciers visually due to poor image quality, excessive 
snow, or cloud coverage over any part of the sample, add the label IQ (insufficient quality). Do not 
assign any label until the sample polygon has been thoroughly inspected. This will help you to ensure that 
all sample polygons in the KML files are inspected.

Table 1: Labelling of sample polygons.

Description Naming (e.g. here sample polygon AA001)

Not yet mapped AA001

Mapped – no rock glacier AA001NR

Mapped – with rock glacier(s) AA001RM

Mapping not possible due to poor image quality, snow cover 
or clouds (even if that applies just to parts of the sample).

AA001IQ

Delineation of rock glacier outlines
Map the individual rock glaciers using the Google Earth ‘polygon’ feature. Delineate the outlines as 
precisely as possible using visual interpretation. To enable subsequent processing, it is important that you 
create a separate folder for the mapped rock glaciers in each sample polygon (RG_MAPPING folders), 
and that you save each rock glacier as a uniquely labelled polygon within this mapping folder. Do not 
create RG_Mapping folders for sample polygons labelled as ‘NR’ or ‘IQ’. Create and name the folders 
and rock glacier polygons as follows. 
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Open the KML files with the sample polygons.
1.	 Right click on the sample polygon to be mapped

2.	Click on ‘Add’ in the dropdown menu that appears.

3.	Click on ‘Folder’ (Figure 8).

4. A new dialogue box ‘Google Earth – New Folder’ appears. Give a name to the folder ‘RG_
MAPPING_name of the sample polygon’ (e.g., ‘RG_MAPPING_AA001’ for all rock glaciers mapped 
within the sample square ‘AA001’), be sure you place the folder below the sample polygon AA001 in 
the KML fines and click ‘OK’ (Figure 9). 

Figure 8: Creating an RG_MAPPING folder inside a sample polygon

Figure 9: Naming the RG_MAPPING folder
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5. 	The folder will be placed at the end of the KML file. Either drag it to the top and place it below the 
sample polygon for which it is created OR right click on the folder, cut, and paste it below the sample 
polygon (Figure 10).

6.	 Right click on the ‘RG_MAPPING’ folder created for the sample polygon.

7.	Click on ‘Add’ in the dropdown menu that appears.

8.	Click on ‘Polygon’ (Figure 10).

9.	A new dialogue box ‘Google Earth – New Polygon’ appears with the name ‘Untitled Polygon’ in the 
name field (Figure 11).

Figure 10: Creating a new polygon inside an RG_MAPPING folder

Figure 11: Dialogue that appears for the new polygon in the RG_MAPPING folder AA001
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10.	Give a name to the polygon for the mapped rock glacier consisting of the name of the sample 
polygon plus the ‘RG’ extension and a number starting from 1. E.g. if a number of rock glaciers are 
encountered within sample polygon AA001, label the first mapped rock glacier as AA001RG1, the 
second as AA001RG2, the third as AA001RG3, and so on, to create a unique name (Figure 12). 
When you have finished inspecting the sample polygon relabel it to AA001RM.

Each person involved in mapping should use a specific colour for the polygon outlines to allow easy visual 
identification of who has mapped a particular rock glacier outline. Click on the Style, Color tab (Figure 
13), and choose a specific colour, width, and opacity for the boundary lines. Delineate the outline of the 
rock glacier using the mouse. Either click and drag the cursor to outline the shape, or click the cursor and 
release to add a single point to the polygon, and repeat to add more points. Try to map only the part of 
the rock glacier that lies within the sample polygon. Even if a mapped outline does cross the boundary of a 
sample polygon, it will be removed during the spatial analysis in ArcGIS so that only rock glacier features 
within the sample polygon are included in the final analysis. Figure 13 shows an example: the outline of a 
rock glacier mapped as ‘AX041RG1’. The parts of the outline with many points were mapped by clicking 
and dragging the cursor, the parts with fewer points were mapped by clicking and releasing the cursor. 

Labelling the rock glaciers
Details of the rock glacier attributes are recorded in the form of labels after the rock glacier polygon 
name. The labels are added in the order: image date, upslope boundary (i.e. origin), activity, longitudinal 
flow structures, transversal flow structures, frontal appearance, outline visualization, snow coverage, and 
overall confidence. Detailed descriptions of how to identify and label the various features are given in the 
following sections. The classification and abbreviations used are given in Table 2. If a rock glacier has 
multiple forms of one attribute, choose the most dominant form, for example, if the front slope of a rock 
glacier is gentle in some places and steep in others, label with the attribute type occupying the greatest 
area or length. The classification ‘unclear’ is used if none of the labels seem to match.

Figure 12: Creating a new polygon in the folder RG_MAPPING_AA001 and labelling it as AA001RG1
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Figure 13: Outline of a rock glacier created using the polygon feature in Google Earth

Save an example set of features 
showing the different attribute 
labels in a single KML file called 
‘Labeling.KML’ in Google Earth 
to use as a reference while 
labelling the rock glaciers. 
Write the abbreviations for the 
labels into the ‘Description’ tab 
of the polygon separated by a 
semicolon. A typical complete 
label might look like this (example 
is for rock glacier 1 in the random 
polygon AD043): AD043RG1_0
3112011;BS;AM;LN;TV;FG;OV;
SP;CM

Image date
The first attribute is the image 
date and shows the image layer 
used for mapping. In default 
images the date is displayed on 
the screen, in images accessed 

Table 2: Labelling the rock glaciers
Attribute Classification Abbreviation

Image date MMDDYYYY
Upslope boundary Glacial BG

Slope BS
Unclear BU

Likelihood active Virtually Certain AVC
High AH
Medium AM

Longitudinal flow structure Clear LC
Vague LV
None LN

Transversal flow structure Clear TC
Vague TV
None TN

Front Steep FS
Gentle FG
Unclear FU

Outline Clear OC
Fair OF
Vague OV

Snow cover Snow SS
Partial Snow SP
No Snow SN

Overall confidence Virtually Certain CVC
High CH
Medium CM
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through a time slider, the image date is shown in the time slider itself or is displayed when the cursor is 
placed on the ‘new polygon’ dialogue. Note the date in the format ‘MMDDYYYY’.

Upslope boundary
The origin of a rock glacier is called the upslope boundary. Three types of boundary area are 
differentiated: ‘Glacial’ if the area is a glacier, abbreviated BG; ‘Slope’ if the area is sloping, abbreviated 
BS, and ‘Unclear’ if the area can’t be defined, abbreviated BU (Figure 14).

Figure 14: Examples for the attribute upslope boundary: A) glacial (BG); B) sloping (BS)  
(orange lines indicate the lower limits of the rock glaciers; red line = 100 m)

                                                (A)                                                            (B)

Activity
It is important to add a label to show how clear the indication is that the rock glacier is active, i.e. 
moving. You can tell this by looking at a combination of the surface relief, the frontal slope, vegetation, 
and the composition of the material. An active rock glacier is characterized by well pronounced 
ridges and furrows (see section ‘Flow structures’), a steep gradient along the frontal slope (see section 
‘Front’), absence of vegetation, and presence of fresh, unweathered material. Three categories are 
used to describe the likelihood that the rock glacier is active: ‘Virtually Certain’, ‘High’, and ‘Medium’, 
abbreviated as AVC, AH, and AM, respectively (Figure 15).
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Figure 15: Examples for the attribute Likelihood Active: 
A) Virtually Certain (AVC); B) High (AH); C) Medium (AM) (red line = 100m). 

Less pronounced visible flow structures and outline and frontal appearance mean less certainty.

                         (A)                                                 (B)                                                     (C)

Flow structures
Rock glaciers can have both longitudinal and transversal flow structures (ridges and furrows). Longitudinal 
and transverse structures are labelled separately; both have three categories: ‘Clear’, ‘Vague’, and 
‘None’, abbreviated for longitudinal structures as LC, LV, and LN (Figure 15), and for transverse structures 
as TC, TV, and TN (Figure 16). 

(A) (B)

(C)

Figure 16: Examples for the attribute ‘Longitudinal flow structure’: 
A) Clear (LC); B) Vague (LV); C) None (LN) (red line = 100m)
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                             (A)                                                                         (B)

Figure 17: Examples for the attribute ‘Transversal flow structure’: 
A) Clear (TC); B) Vague (TV); C) None (TN) (red line = 100m)

Front 
Three categories are used to describe the slope of the attribute ‘Front’: ‘Steep’, ‘Gentle’, and ‘Unclear’, 
abbreviated as FS, FG, and FU, respectively (Figure 18). ‘Steep’ means that the front slope is at a steep 
angle relative to the horizontal plane and is indicated by the presence of loose material along the front 
slope which has a lighter colour than the material on the rock glacier surface. At this angle, the material 
on the slope face is on the verge of sliding.

                           (A)                                                              (B)

Figure 18: Examples for the attribute ‘Front’: A) Steep (FS); B) Gentle (FG) (red line = 100m)

(C)
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Outline
Mapping of rock glacier outlines using Google Earth images is subjective. The attribute ‘Outline’ is 
used to indicate how clear the outline appears to the person doing the mapping. The attribute has three 
categories: ‘Clear’, ‘Fair’, and ‘Vague’, abbreviated as OC, OF, and OV, respectively (Figure 19).

                              (A)                                                                    (B)

(C)   

Figure 19: Examples for the attribute ‘Outline’: A) Clear (OC); B) Fair (OF); C) Vague (OV) (red line = 100m).
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Snow cover
The presence of snow on the rock glacier is indicated by the attribute ‘Snow Cover’. There are three 
categories: ‘Snow’, ‘Partial Snow’, and ‘No Snow’, abbreviated as SS, SP, and SN, respectively (Figure 20). 

 (A)   (B)  

 (C)  

Figure 20: Examples for the attribute ‘Snow Cover’: A) Snow (SS); B) Partial Snow (SP);  
C) No Snow (SN) (red line = 100m)
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Overall confidence
The final attribute ‘Overall Confidence’ summarizes the overall impression of the degree to which all the 
features together are consistent with the mapped feature being a rock glacier. There are three categories: 
‘Virtually Certain’, ‘High’, and ‘Medium’, abbreviated as AVC, AH, and AM, respectively (Figure 21). 

 (B)   (A)  

 (C)  

Figure 21: Examples for the attribute ‘Overall Confidence’: A) Virtually Certain (CVC);  
B) High (CH); C) Medium (CM) (red line = 100m)
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 (A)

 (C)

 (B)

 (D)

Figure 22: Examples of rock glaciers with their full set of attribute labels: 

A) 	 (AD043RG1_03112011;BS;AM;LN;TV;FG;OV;SP;CM); 
B   	 (AS029RG1_07292008;BG;AVC;LC;TC;FG;OF;SP;CVC); 
C)  	 (AD005RG1_10142011;BS;AM;LV;TN;FS;OF;SN;CM); 
D)	  (AC010RG2_12202006;BS;AH;LV;TN;FS;OF;SP;CH) (red line = 100m)
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Other features
Adding attributes increases the confidence that the structures observed really are rock glaciers. During 
mapping we encountered other structures that indicate ground movement or creep, but which couldn’t be 
linked to the presence of ice or permafrost with any certainty. These structures were not mapped as rock 
glaciers; some examples are shown in Figure 23. Further investigations will be needed to clarify whether 
permafrost plays a role in their existence. 

 (D)

 (B)

 (C)

 (A)

Figure 23: Examples of creeping ground features without sufficient attributes 
to be classified as a rock glacier (red line = 100m)
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2.4  Spatial attributes of the mapped rock glaciers
Once mapping is complete, the KML files are imported from Google Earth to ArcGIS to determine which 
parts of the rock glaciers have been mapped by both observers and extract the spatial attributes. Figure 
24 shows the procedure in the form of a flow chart. The individual steps are described in detail in the 
following sections.

Figure 24: Flow chart illustrating the overall procedure to extract the spatial attributes  
from commonly mapped rock glaciers using ArcGIS
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First set of shapefile
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statistics of the 
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in table form

Rock glaciers within the sample 
polygons in the first set

Rock glaciers within the sample 
polygons in the second set

Sample polygons 
only (rock glaciers 

removed

Mapped rock glaciers only in the first 
set (sample polygons removed)

Mapped rock glaciers only in 
the second set (sample polygons 

removed)

Sample polygons 
only (rock glaciers 

removed)

Second set  
of shapefile

Duplication of layer Duplication of layer

Commonly mapped part of 
rock glaciers

Converts multipart features  
of single part features

Obtain data for first-order 
validation of permafrost 
maps or other purpose

KML to Layer

Minimum two layers 
of shapefile

Clip Clip

Intersect

Multipart to Singlepart

Join

Zonal Statistics  
as Table
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2.4.1	 Extracting statistical attributes for the mapped rock glacier polygons  
		  and sample polygons

The following steps are carried out separately for the KML files mapped by the different observers (M1 
and M2 and so on).

1. 	Convert the KML file created in Google Earth into a layer file in ArcGIS using the Conversion Tools. 
This tool creates a file geodatabase containing a feature class (e.g. File_name.gdb or M1.gdb).

	 ArcToolbox > Conversion Tools > From KML > KML To Layer

2. 	To view the converted file (polygons), navigate to the folder where geodatabase (File_name.gdb or 
M1.gdb) is stored. The polygon file will be placed within placemarks.

	 Add Data > File_name.gdb > Placemarks > Polygons

3. 	Duplicate the layers and create two separate polygon files, one with only rock glaciers and one with 
only sample polygons. 

	 Right click on the Polygons.shp and choose 

	 Data > Export Data 

	 to create a shape file with the file name ‘RG.shp’ (the file that will have only rock glaciers); repeat to 
make a second file named ‘Sample.shp’ (the file that will have only sample polygons) (Figure 25). 
The separate sets of files from the two observers will have different names, i.e. RG_M1.shp and RG_
M2.shp, and Sample_M1.shp and Sample_M2.shp.

Figure 25: Creation of two shp files: A) Duplication of the Polygon.shp layer using the ‘Export Data’ tool;  
B) creation of RG.shp; C) creation of Sample.shp

                       (B)                                                  (C)

 (A)  
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�� Right click on the shapefile ‘RG.shp’ and click Open Attribute Table. 
�� 	Sort the PopupInfo column by double clicking on the column header. The rock glaciers will be listed at 

one end of the column and the sample polygons at the other. 
�� 	Use the editor tool bar to remove the sample polygons. (If the editor tool bar is not activated, then use 

the ‘Customize’ root menu to show it as a dockable window on the menu bar. Customize > Toolbars 
> Editor). Click on ‘Editor’, select ‘Start Editing’, and delete all sample polygons (i.e. all rows with 
empty PopupInfo) leaving a file with all the rock glacier polygons. Save.

�� 	Repeat for the shapefile ‘Sample.shp’ but delete all the rock glacier polygons (with PopupInfo 
containing information). 

�� 	Save the files. You should now have two shape files, one with only rock glaciers and other with only 
sample polygons (Figure 26). Keep a backup of both files.

Figure 26: Two shapefiles: one with rock glacier polygons only (RG),  
the other with sample polygons only (Sample)

4.	 Use the command Repair Geometry to RG.shp to fix any geometry problems in the rock glacier polygons.

	 ArcToolbox > Data Management Tools > Features > Repair Geometry

5. Use the command Clip to remove any rock glacier parts lying outside the sample polygons.

	 ArcToolbox > Analysis Tools > Extract > Clip

Use the following input and output parameters:
�� 	‘Input Features’ is RG.shp
�� 	‘Clip Features’ is Sample.shp
�� 	Choose a suitable name and location in ‘Output Feature Class’, e.g. RG_clip
�� 	‘XY tolerance’ is 0
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6. 	Use the command Zonal Statistics as Table for RG_clip.shp (RGM1_clip.shp and RGM2_clip.shp) and 
Sample.shp (RGM1_ Sample.shp and RGM2_ Sample.shp) to prepare a table with the values given 
in the DEM for the zones within each shapefile.

	 ArcToolbox > Spatial Analyst Tools > Zonal > Zonal Statistics as Table

	 Use the following input and output parameters (Figure 27A):
�� 	‘Input raster or feature zone data’ is RG_clip.shp or Sample.shp
�� 	‘Zone field’ is the field that holds the values that define each zone. In this case it is ‘Name’ of 

mapped rock glaciers.
�� 	‘Input value raster’ is a DEM of the study area.
�� 	In ‘Output table’ give a suitable name, e.g. RG_stats or Sample.stats.
�� 	If any very small mapped rock glacier areas are not taken into account because they are too small 

(i.e. NULL values after clipping, see below), the Cell Size in Environments > Raster Analysis must 
be set to a smaller value, for example, half the size of the cells in the DEM. Don’t use a value 
smaller than 0.000133333333333333 or the computation will be extremely slow (Figure 27B).

Figure 27: Preparation of tables with the statistics from the DEM for the zones within the files: 
A) setting the parameters; and B) changing the environmental settings

 (A)   (B)  

7. 	 Join the table with the zonal statistics with the corresponding layer as follows. Right click on layer 
(RG_clip or Sample) and choose

	 Joins and Relates > Join

	 Use the following input and output parameters:
�� 	Choose ‘Name’ from the drop down menu as the field on which the join will be based.
�� 	Choose previously created table (RG_stats or Sample.stats) from the dropdown menu to join to this 

layer.
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2.4.2	 Extracting minimum elevation of the commonly mapped areas of rock glaciers

Each square sample polygon is mapped separately by at least two observers. Differences in delineating 
rock glaciers are inevitable, especially the upper limit of the glacier and the separation between 
individual rock glaciers. Usually the lower limit of rock glaciers can be more easily recognized than the 
upper limits. However, to ensure that the data sets are robust and that the final estimates of the elevation 
of the lower limit are conservative, only areas identified as rock glaciers by both observers are included in 
the assessment. 

1. 	Use the Intersect tool to extract the commonly mapped areas.

	 ArcToolbox > Analysis Tools > Overlay > Intersect

	 Use the following input and output parameters:

�� 	‘Input Features’ are RG_M1.shp and RG_M2.shp
�� 	Choose a suitable name for ‘Output Feature Class’, e.g. M1interM2.shp.

 (C)   (D)  

 (A)   (B)  

Figure 28: Procedure for calculating latitude and longitude of sample polygons or rock glaciers

8. 	Calculate the latitude/longitude for each sample polygon and rock glacier as follows (Figure 28). 

�� 	Right click on the layer (e.g. Sample or RG) and choose Open Attribute Table. Click ‘Add field’ 
in the drop down menu of ‘Table Options’. In ‘Name’ write Longitude or Latitude; in the drop 
down menu of ‘Type’ select ‘Double’; and click OK. Edit the session using the Editor tool bar 
(as described above). Right click on the recently added field (Longitude or Latitude) and choose 
Calculate Geometry (under ‘Property’ choose ‘Y Coordinate of Centroid’ for latitude or ‘X 
Coordinate of Centroid’ for longitude).



25

2. 	Use Multipart to Singlepart to separate the multipart features into single part features. 

	 ArcToolbox > Data Management Tool > Features > Multipart to SinglePart

	 Use the following input and output parameters:
�� 	‘Input Features’ is M1interM2.shp 
�� 	Choose a suitable name for  ‘Output Feature Class’ e.g. M1interM2_ms.shp
�� 	XY tolerance’ is 0

3. 	Use the Zonal Statistic command as a Table for M1interM2_ms.shp to summarize all values and take 
the lowest value for each polygon from the DEM within the zones of the given shapefile in a table 
(Figure 27).

	 ArcToolbox > Spatial Analyst Tools > Zonal > Zonal Statistics as Table

	 Use the following input and output parameters:
�� 	‘Input raster or feature zone data’ is M1interM2_ms.shp 
�� 	‘Zone field’ is the field that holds the values that define each zone. In this case it is Name.
�� 	‘Input value raster’ is a DEM of the study area.
�� 	In ‘Output table’ give a suitable name, e.g. M1M2_RG_stats
�� 	If any very small mapped rock glacier areas are not taken into account because they are too 

small (i.e. NULL values after joining), the Cell Size in Environments > Raster Analysis must be set 
to a smaller value, for example, half the size of cells in the DEM. Don’t use a value smaller than 
0.000133333333333333 or the computation will be extremely slow.

4. 	 Join the M1M2_RG_stats table with the corresponding layer as follows. Right click on layer 
(M1interM2_ms.shp) and choose

	 Joins and Relates > Join

	 Use the following input and output parameters:
�� 	Choose ‘Name’ from the drop down menu as the field on which the join will be based.
�� 	Choose previously created table (M1M2_RG_stats) from the dropdown menu to join to this layer.

The result is a table containing data showing the names of individual commonly mapped rock glaciers 
together with the minimum elevation of their termini, assigned attributes, and position coordinates.
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3.	Example of Application: Rock 
Glacier Mapping in the HKH 
Region using Google Earth

A total of 4000 randomly distributed sample squares were created in GNU R within the boundary 
coordinates of the HKH as defined by ICIMOD. The total area of the randomly distributed squares 
was close to 2% of the total HKH area. The 4000 squares were divided into four sets of 1000 sample 
polygons. These sets were stored in four separate Keyhole Markup Language (KML) files and referred to 
as ‘HKH_1000_1.kml’, ‘HKH_1000_2.kml’, ‘HKH_1000_3.kml’, and ‘HKH_1000_4.kml’. Each sample 
polygon inside these KML files was given a unique name consisting of two capital letters and three digits 
between 001 and 100. Table 3 shows the alphabetical prefixes used for the four sets of KML files.

Table 3: Assigning attributes to sample polygons

KML FILES

HKH_1000_1.kml HKH_1000_2.kml HKH_1000_3.kml HKH_1000_4.kml

AA AK AU BE

AB AL AV BF

AC AM AW BG

AD AN AX BH

AE AO AY BI

AF AP AZ BJ

AG AQ BA BK

AH AR BB BL

AI AS BC BM

AJ AT BD BN

Each sample polygon was mapped independently by two of the three observers performing mapping 
(Table 4) to give two mapping layers (M1 and M2) for each set of KML files.
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Table 4: Mapping of sample polygons

Set 1 Set 2 Set 3 Set 4

Sample M1 M2 Sample M1 M2 Sample M1 M2 Sample M1 M2

AA     AK     AU     BE    
AB     AL     AV     BF    
AC     AM     AW     BG    
AD     AN001-AN033     AX     BH    
AE     AN034-AN100     AY     BI    
AF     AO     AZ     BJ    
AG     AP     BA     BK    
AH     AQ001-AQ067     BB     BL    
AI     AQ068-AQ100     BC     BM    
AJ     AR     BD     BN    
      AS                
      AT                

Observer 1  

Observer 2  

Observer 3  

The outlines were drawn using a line width of ’5.0‘, Opacity ‘100%’, Area Colour ‘White’, ‘Filled 
+ Outlined’, and Opacity ‘0%’ (Figure 13) using blue, yellow, or orange for Observers 1,2, and 3, 
respectively. The rock glaciers were mapped as described above. The results are given in (Schmid 
et al. 2015) and can be downloaded as supplementary material from http://www.the-cryosphere.
net/9/2089/2015/tc-9-2089-2015-supplement.zip.
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About ICIMOD

The International Centre for Integrated Mountain Development, ICIMOD, is a regional knowledge 

development and learning centre serving the eight regional member countries of the Hindu Kush 

Himalayas – Afghanistan, Bangladesh, Bhutan, China, India, Myanmar, Nepal, and Pakistan – and 

based in Kathmandu, Nepal. Globalization and climate change have an increasing influence on 

the stability of fragile mountain ecosystems and the livelihoods of mountain people. ICIMOD aims 

to assist mountain people to understand these changes, adapt to them, and make the most of new 

opportunities, while addressing upstream-downstream issues. We support regional transboundary 

programmes through partnerships with regional partner institutions, facilitate the exchange of 

experience, and serve as a regional knowledge hub. We strengthen networking among regional 

and global centres of excellence. Overall, we are working to develop an economically and 

environmentally sound mountain ecosystem to improve the living standards of mountain populations 

and to sustain vital ecosystem services for the billions of people living downstream – now, and for 

the future. 
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